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Introduction

This tutorial takes you through the steps of using IBM® IMS™ Enterprise Suite Explorer
for Development Version 3.1 to write a Java™ application to access IMS databases
through the IMS Universal JDBC driver and the IMS Universal DL/I driver.

Customers who store business data in IMS databases want an easy way to access their
data. They also want to be able to develop applications for IMS using modern and
standardized programming solutions. The IMS Universal drivers, part of the IMS Version
13 Open Database solution, are software components that provide Java applications with
connectivity to IMS databases from z/OS® and from distributed environments through
TCP/IP.

The IMS Universal drivers are built on industry standards and open specifications. Java
applications that use the IMS Universal drivers can reside on the same logical partition
(LPAR) or on a different LPAR from the IMS subsystem. Two types of connectivity are
supported by the IMS Universal drivers: local connectivity to IMS databases on the same
LPAR (type-2 connectivity) and distributed connectivity through TCP/IP (type-4
connectivity).

This tutorial will help to familiarize you with using two of the IMS Universal drivers:

e IMS Universal JDBC driver, which provides a stand-alone Java Database
Connectivity (JDBC) 3.0 driver for making structured query language (SQL)-
based database calls to IMS databases.

¢ IMS Universal DL/I driver, which provides a stand-alone Java application
programming interface (API) for writing granular queries to IMS databases using
programming semantics similar to traditional IMS DL/I calls

In this tutorial, you will run Java applications in a Windows® environment and connect
to the IMS database using type-4 connectivity mode.
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Distributed and local connectivity with the IMS Universal drivers

The IMS Universal drivers support distributed (type-4) and local (type-2) connectivity to IMS databases. The
connectivity type is specified in the driverType connection property. In this tutorial exercise, you will use type-
4 connectivity.

Type-4 connectivity: With type-4 connectivity, the IMS Universal drivers can run on any platform that
supports TCP/IP and a Java Virtual Machine (JVM), including z/OS. To access IMS databases using
type-4 connectivity, the IMS Universal drivers first establish a TCP/IP-based socket connection to IMS
Connect. IMS Connect is responsible for routing the request to the IMS databases using the Open
Database Manager (ODBM), and sending the response back to the client application. The DRDA®
protocol is used internally in the implementation of the IMS Universal drivers. You do not need to
know DRDA to use the IMS Universal drivers.

Figure 1: Distributed (type-4) connectivity
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Type-2 connectivity: Local (or type-2) connectivity with the IMS Universal drivers is targeted for the
z/OS platform and runtime environments. You would use type-2 connectivity when connecting to IMS
subsystems in the same logical partition (LPAR). In this tutorial, you will not need type-2 connectivity.

Objectives

To understand and gain hands-on experience creating Java applications to access and
manipulate enterprise data residing on the IMS database.

Upon completion of this study, you will be able to perform these tasks:

e Create a Java application to access IMS data by issuing SQL calls to the IMS
database through the IMS Universal JDBC driver

e Create a Java application to access IMS data by issuing IMS DL/I calls to the IMS
database through the IMS Universal DL/I driver

¢ Deploy and run a Java application in a Windows environment
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System requirements for the tutorial:

Software installed on Windows
e IMS Enterprise Suite Explorer for Development Version 3.1
e IMS Universal drivers libraries
o imsudb.jar
e Sample Java project
o IMSDBJavaApplicationLab.zip

System software installed on IBM z/OS
e IMS Version 13 configured with Open Database Manager (ODBM)
e [IMS Connect Version 13

Checklist for first-time implementation

You may find it helpful have the following information and resources ready before
proceeding with your first implementation of the Java applications using the IMS
Universal drivers. The information and resources to run this tutorial is provided in the
checklist below.

Table 1: Implementation checklist

Information or resource Your For this tutorial
environment

IMS Connect host name  Obtain this Host name:
(or IP address) and DRDA information from ZSERVEROS.DEMOS.IBM.COM
port number IMS system
programmers. DRDA port number: 7001
IMS data store name (IMS Obtain this Datastore name: IMSD
ID) information from
IMS system
programmers.
z/OS user ID and Obtain this Userid: EM4ZIMS
password information from
IMS system
programmers.
MetadataURL to the Java Obtain this MetadataURL:(DatabaseName)
metadata file generated information from class://com.ibm.ims.db.databaseviews.DFSS
by the IMS Explorer IMS application AMO9DatabaseView
programmers.

Workspace directory and A naming standard Workspace directory:
project name to be used is recommended. C:\share\imsjavalab\workspace
when generating artifacts



Overview of development tasks

To complete this tutorial, you will perform the following tasks:
1 Task 1 - Install the tutorial sample project

1.1Switch to the Java perspective
1.2Import the IMSDBJavaApplicationLab sample project
1.3Verify that the IMS Universal drivers library is located on the build path

2 Task 2 - Access IMS data with the IMS Universal JIDBC driver

2.1Connect to the IMS database through the IMS Universal JDBC driver
2.1.10pen the JIDBCApiAssignment.java sample application
2.1.2Set the connection properties
2.2lIssue SQL calls to access the IMS database
2.2.1 Exercise 1 - Retrieve all fields of a segment
2.2.2 Exercise 2 - Retrieve fields of a segment based on a conditional statement
2.2.3 Exercise 3 - Order SQL query output by field values
2.2.4 Exercise 4 - Retrieve a specific field of a segment
2.2.5 Exercise 5 — Retrieve multiple fields from multiple segments

3 Task 3 — Access IMS data with the IMS Universal DL/l driver

3.1Connect to the IMS database through the IMS Universal DL/I driver
3.1.1 Open the DLIAPIAssigment.java sample application
3.1.2 Set the connection properties
3.21ssue DL/I calls to access the IMS database
3.2.1 Exercise 1 - Retrieve data in an IMS database
3.2.2 Exercise 2: Retrieve batch data in an IMS database
3.2.3 Exercise 3: Create SSALIists with multiple segments, specify qualifications,
and mark specific fields for retrieval
3.2.4 Exercise 4: Utilize command codes for DL/I



e Task 1 - Install the tutorial sample project

In this task, you will import the tutorial sample project to IMS Enterprise Suite Explorer
for Development, and verify that the Java library with the code to run the IMS Universal
DL/I and JDBC drivers is installed.

Switch to the Java perspective
Switch from the default z/OS Projects perspective to the Java perspective.

1. IMS Enterprise Suite Explorer for Development is started and you are using the
C:\share\imsjavalab\workspaceas your workspace directory.

Important:
For this tutorial, you will use C:\share\imsjavalab\workspace as your workspace
directory.

The Workspace

In Explorer, a workspace is a directory that stores files for your projects. You can select your
own directory or take the default directory. Artifacts created by Explorer will be stored in
this directory.

2. From the menu bar, select Window > Open Perspective > Other.

Figure 2: Opening a perspective in IMS Enterprise Suite Explorer for Development
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3. Scroll down and select Java from the Open Perspective dialog box.
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Figure 3: Choosing the Java perspective
& Open Perspective |:|@

£ c1cs sM

C'u'S Repository Exploring
|45 Database Debug

[3 Database Development
ﬁDebug

EEnterprise Service Tools
E% Fault Analyzer Perspective

<¥m

@ Java Browsing

4. Press OK to switch to the Java perspective.
5. To verify that you are in Java perspective, make sure that the Java button appears
in the upper right corner of Explorer, as shown in the figure below.

Figure 4: Verifying that the Java perspective is opened.
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What is a perspective?

A perspective defines the initial set and layout of views in the Workbench window. Within the window,
each perspective shares the same set of editors. Each perspective provides a set of functionality
aimed at accomplishing a specific type of task or works with specific types of resources. For example,
the Java perspective combines views that you would commonly use while editing Java source files,
while the Debug perspective contains the views that you would use while debugging Java programs.

Import the IMSDBJavaApplicationLab sample project

Import the files for the IMSDBJavaApplicationLab sample project into the Explorer
workspace.

The IMSDBJavaApplicationLab sample project

The sample project includes the Java library that contains the IMS Universal drivers
required for this tutorial. The sample also includes sample Java application code that you
will customize to connect to an IMS database and issue database access calls.

1. From the menu bar, click File > Import to open the Import dialog box.
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Figure 5: Launching the Import dialog box
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2. From the Import dialog box, select General > Existing Projects into Workspace
and click Next.

Figure 6: Launching the Import Existing Projects into Workspace wizard
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3. From the Import Projects page, select Select archive and click Browse.
4. Browse to the directory C:\IMS Java Lab choose
IMSDBJavaApplicationLab.zip and click Open.




Figure 7: Importing a project from an archive file
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5. Make sure that the checkbox for IMSDBJavaApplicationLab is selected and
click Finish.

The sample project IMSDBJavaApplicationLab should appear in the Package Explorer
view.
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Figure 8: Package Explorer view after successfully importing the sample project
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Verify that the IMS Universal drivers library is located on the build
path

Verify that the Java archive file imsudb.jar is correctly located in the build path of this
project.

1. Right click on the project in the Package Explorer view and select Build Path >
Configure Build Path

Figure 9: Opening the Java Build Path properties page
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2. From the Java Build Path page, click on the Libraries tab. Verify that the file
imsudb.jar — IMSDBJavaApplicationLab is present.

The imsudb.jar library
The imsudb.jar file contains the Java classes, interfaces, and metadata required to use the
IMS Universal DL/I driver and the IMS Universal JDBC driver.

Figure 10: Verifying that the imsudb.jar library is in the build path
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3. Click OK to save your changes and exit the Java Build Path page.
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e Task 2 - Access IMS data with the IMS Universal JDBC
driver

In this task, you will write a Java application to connect to an IMS database and
manipulate data using structured query language (SQL) with the IMS Universal JDBC
driver.

What is JIDBC?

Java Database Connectivity (JDBC) is an application programming interface (API) that
Java applications use to access relational databases or tabular data sources. The JDBC API
is the industry standard for database-independent connectivity between the Java
programming language and any database that has implemented the JDBC interface. The
client uses the interface to query and update data in a database.

IMS support for JIDBC lets you write Java applications that can issue dynamic SQL calls to
access IMS data and process the result set that is returned in tabular format. The IMS
Universal JDBC driver is designed to support a subset of the SQL syntax with functionality
that is limited to what the IMS database management system can process natively. Its
DBMS-centric design allows the IMS Universal JDBC driver to fully leverage the high
performance capabilities of IMS. The IMS Universal JDBC driver also provides aggregate
function support, and ORDER BY and GROUP BY support.

Basic programming model for a Java application using the IMS Universal JDBC
driver

The IMS Universal JDBC driver supports the standard programming model for using JDBC
drivers. For more information about the JDBC programming model, see the JDBC Basics
tutorial by SUN.

Connect to the IMS database through the IMS Universal JDBC driver

Before you can execute SQL calls from your IMS Universal JDBC driver application,
you must connect to an IMS database.

Open the JDBCApiAssignment.java sample application

The JDBCApiAssignment.java sample application
This sample application contains skeleton Java code for connecting to the IMS database and
issuing SQL data access calls using the IMS Universal JDBC driver.

1. Inthe Package Explorer view, expand IMSDBJavaApplicationLab > src >
com.ibm.ims.db.exercise
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Figure 11: Navigating to the JDBCApiAssignment.java sample application
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2. From the Package Explorer view, double click on JDBCApiAssignment.java to
open the sample application in the Java editor.

Figure 11: The opened JDBCApiAssignment.java sample application in the Java editor
[J| IDBCApiAssignment.java 52

package com.ibm.ims.db.exercise;
Fimport jJava.sgl.Connection:s[]

pobklic class JDECApifNssignment {

= public =tatic void main(Stcring[[] args) {
JDBEBCApiAssignment j = new JDBCApiAssignment () 7

Maximizing a view is the ability to increase a view to the maximum possible size on the screen. This
can be accomplished by double-clicking on the view tab. To go back to the original view size, double-
click on the view tab again.

Set the connection properties

The Java editor

The Java editor provides specialized features for editing Java code. The editor includes
support for syntax highlighting, content/code assist, code formatting, import assistance, and
integrated debugging features.
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Figure 13: Java main method in the JDBCApiAssighment.java sample application
|E IMS Explorer Task Launcher  |& JDBCApiAssignmentjava 2
1 package com.ibm.ims.db.exercise;

2

3® import java.sqgl.Connection;[]

10

11 public class JDBCApiAssignment {
12

3= / >k

* @param args

S */

6= public static void main(String[] args) {

JDBCApiAssignment j = new JDBCApiAssignment();

//TODO Add a SQL statement between the quotes
String query = "";

String result = j.sglMethod(query,REPLACE THIS );

1. Inthe Java editor, scroll down the application source code until you find the Java
main method shown in the screenshot above.

Moving your cursor to a specific line number

Explorer provides a shortcut to move your cursor directly to a specific line in an editor. To go to a
specific line, press Ctrl + L from the editor. Enter the line number and press OK.

Displaying line numbers in the editor

Line numbers can be displayed directly in the editor by going to Windows > Preferences. In the
Preferences Dialog Menu navigate to General > Editors > Text Editors and check the box next to
Show line numbers.

Figure 124: Configuring the editor to display line numbers
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2. Inline 22 of the code, delete the constant REPLACE_THIS and replace it with
IMSConnectionSpec.DRIVER_TYPE_4 to set the driver connectivity type.

3.
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Java code assist

Explorer provides code assist for Java applications. By pressing CTRL + space, the Java editor will
display a list of possible commands variables for that line. Try specifying the driver type by typing IMS
and pressing CTRL + space and scrolling to the constant IMSConnectionSpec. Alternatively, when
you type a period (.) after a class, the Java code assist displays a menu of methods and variables
that the class can invoke. Try it after IMSConnectionSpec and select DRIVER TYPE 4.

4. In line 32 of the code, delete the string ""your.host.name.com’" and replace it
with "'zserveros.demos.ibm.com™ to set the host.

Figure 15: Setting the connection properties
2 IMS Explorer Task Launcher | JDBCApiAssignmentjava 52

27 public String sqlMethod(String sqlQuery, int driverType){

28 StringBuffer result = new StringBuffer();

29

430 // TODO - assign the host name or IP address of the IMS Connect you are connecting to.
32 String host = "your.host.name.com";

33 String datastoreName = ""; // The IMS alias name defined in ODBM

34 String username = "yourID"; // User Name

35 String password = Vault.getPassword(username);; // Password

int drdaPort = 7001; // the ICON DRDA port number
37 IMSDataSource ds = new IMSDataSource();
a38 ds.setMetadataURL(REPLACE THIS);

39 ds.setDatastoreName(datastoreName);
40 ds.setPortNumber(drdaPort);

41 ds.setDatastoreServer(host);

42 ds.setUser(username);

43 ds.setPassword(password) ;

44 ds.setDriverType(driverType);

The datastoreServer property

The host variable in the sample application is used to set the datastoreServer property. This
connection property contains the name or IP address of the data store server (IMS Connect). You
can provide either the host name (for example, dev123.svl.ibm.com) or the IP address (for example,
192.166.0.2). In this tutorial, the target IMS Connect has already been pre-configured for you. Use
zserveros.demos.ibm.com as the dataStoreServer.

5. Inline 33 of the code, delete the string "*** and replace it with “IMSD™" to set the
datastoreName.

The datastoreName property

This connection property contains the name of the IMS data store to access. When using type-4
connectivity, the datastoreName property must match either the name of the data store defined to
Open Database Manager (ODBM) or be blank. In this tutorial, the target IMS data store has already
been created for you and pre-populated with data. Use IMSD as the dataStoreName.

6. In line 34 of the code, delete the string ""'yourID" and replace it with
"EM4ZIMS" to set the username.

The user and password properties

The user and password connection properties are the user name and password used for the
connection to IMS Connect. This information can typically be obtained from your RACF®
administrator.

16




7. Inline 36, verify that 7001 is set as the IMS Connect DRDA port number.

The portNumber property

The drdaPort variable in the sample application is used to set the portNumber property. This
connection property is the TCP/IP server port number to be used to communicate with IMS Connect.
The portNumber property is not required when using type-2 connectivity. In this tutorial, the target
IMS Connect has already been pre-configured for you. Use 7001 as the drdaPort.

8. Inline 38 of the code, delete the constant REPLACE_THIS and replace it with
the string **class://com.ibm.ims.db.databaseviews.DFSSAMO09DatabaseView"
to set the metadataURL.

The metadataURL property

This connection property is the location of the database metadata representing the target IMS
database. The metadataURL property is the fully qualified name of the Java metadata class
generated by the IMS Enterprise Suite DLIModel utility plug-in, based on the PSB and DBD source
files of the target IMS database. The Java metadata class must be generated before coding a Java
application to access the target IMS database using the IMS Universal drivers. The format of the
metadataURL is: “class://packageName.className”

In this tutorial, the Java metadata class has already been generated for you. Use
class:\\com.ibm.ims.db.databaseviews.DFSSAM09DatabaseView as the metadataURL.

Figure 13: Setting the metadataURL connection property
L1l JDBCApiAssignmem.java

7¢ public String sqlMethod(String sqlQuery, int driverType){
28 StringBuffer result = new StringBuffer();
// TODO - assign the host name or IP address of the IMS Connect you are connecting to.
32 String host = "your.host.name.com";
33 String datastoreName = ""; // The INMS alias name defined in ODBM
34 String username = "yourID"; // User Name
35 String password = Vault.getPassword(username);; // Password
36 int drdaPort = 7001; // the ICON DRDA port number

IMSDataSource ds = new IMSDataSource();
ds.setMetadataURL(REPLACE THIS);

39 ds.setDatastoreName(datastoreName);
40 ds.setPortNumber(drdaPort);

41 ds.setDatastoreServer(host);
42 ds.setUser(username);

43 ds.setPassword(password);

A4 ds.setDriverType(driverType);

145
9. Press Ctrl + S to save your code changes.

After completing this step, your Java application should be ready to connect using the

Universal JDBC driver. Next, you will need to modify the Java application code to issue
SQL calls to IMS.
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The Parts Order sample database

This tutorial uses the Parts Order database that is provided in the IMS Installation Verification
Program (IVP). You can refer to this diagram when working on the exercises in this tutorial.

The diagram below shows the hierarchical structure of the segments in the Parts Order database.
Each rectangle represents a database segment. PARTROOT is the root segment of this database,
and STANINFO and STOKSTAT are its child segments. STOKSTAT has CYCCOUNT and
BACKORDR as its child segments. Each segment contains one or more fields that contain data. For
example, PARTKEY is a field in the PARTROOT segment.

Figure 14: Segments of the Parts Order database (reference only)
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Issue SQL calls to access the IMS database

The following exercises in this section will show you how to issue SQL calls in your Java
application to retrieve data from the IMS database using the IMS Universal JDBC driver.

How do IMS database elements map to relational database elements?

The IMS Universal JDBC driver performs the necessary translation between IMS and relational
database elements. The table below summarizes the database element mappings.

Hierarchical database elements in IMS

Equivalent relational database elements

Segment name

Table name

Segment instance

Table row

Segment field name

Column name

Segment unique key

Table primary key

Virtual foreign key field

Table foreign key

Exercise 1 - Retrieve all fields of a segment

In this exercise, you will retrieve all the fields of a segment by issuing a SELECT
statement using the IMS Universal JDBC driver.

Using the SELECT keyword

Use the SELECT statement to retrieve data from one or more tables. The result is returned in a
tabular result set. The syntax for a simple SELECT query is:

SELECT column_name(s) FROM table_name

An asterisk * can be used in place of column_name to represent all columns of that table. Because
IMS is a hierarchical database, column_name maps to field_name and table_name maps to

segment_name.

When using the SELECT statement with the IMS Universal JDBC driver:

e |If you are selecting from multiple tables and the same column name exists in one or more of
these tables, you must table-qualify the column or an ambiguity error will occur.

e The FROM clause must list all the tables you are selecting data from. The tables listed in the
FROM clause must be in the same hierarchic path in the IMS database.

e InJava applications using the IMS JDBC drivers, connections are made to PSBs. Because
there are multiple database PCBs in a PSB, queries must specify which PCB in a PSB to
use. To specify which PCB to use, always qualify segments that are referenced in the FROM
clause of an SQL statement by prefixing the segment name with the PCB name. You can
omit the PCB name only if the PSB contains only one PCB.

1. Move your cursor to line 20 of the sample application. You will modify this
statement to issue different SQL queries in this task.
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Figurel8: Modify the query string to issue different SQL queries in the sample application
[J| IDBCApiAssignment.java 3

y Add a 5QL statement between the guotes
String query = "";

String result = j.=sglMethod (gquery, IMSConnectio

2. Inline 20, construct a SQL query to retrieve all of the fields of the
PARTSPCB1.PARTROOT segment. Note that the segment name must start
with the PCB qualifier.

e Set the query string to "SELECT * FROM PARTSPCB1.PARTROOT"
Press Ctrl + S to save your changes to the files.

4. Right click on the Java editor and select Run As > Java Application

L

Figurel9: Run As Java Application

— Try running the application
} catch (DLIException &) {
< Undo Typing Ctrl+Z
H
= private Open Dedaration F3 atchRetrieve (F5BE psb) {

try Open Type Hierarchy F4
Open Call Hierarchy — Ctrl+Alt+H
Show in Breadcrumb  Alt+Shift+8
Quick Outline Cirl+0

FCE PRRTSFCEL

("PARTSPCB1") ;

Quick Type Hierarchy Ctri+T ungualified 55A List contai
Show In Alt+shift+w ¥
1 .getSSAList ("EARTROOT™) ;
Copy Qualified Mame rieve call
Paste Crl+v izsue a batchRetriewe
nSet or a set of IORRERA's.
Quick Fix Cirl+1 presents data from a single
Source Alt+shift45 * Btabase.
Refactor Alt+5hift+T ¥
Local History 4
Y E\CPARTAWC\CPARTDESC") ;
References Lo
Dedarations L4
[E4 Add to Srippets... foesn't have another path.
o 1RunonServer  Alt4Shift+X, R
Debug As 4 2 Java Application Alt+shift+x, 1
Profile As L4
validate Run Configurations. ..

5. An Errors in Workspace dialog box will appear but you can safely ignore it.
Click on Proceed to continue.
6. Inthe Console view, verify that the result output looks like the screenshots below.
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Figure20: Beginning of Task 2 - Exercise 1 result output
[L Problems | @ Javadoc @ Declaration ﬁ'@.ﬁ.nnn:ntaﬁn:nns El console i3

<terminated = JDBCApiAssignment [Java Application] C:\Program Files\IBM\SDPYidkhinjavaw.exe

PLRTEEY FAERT FARTDESC
02AN9e0C10 AN960C1O WASHER
02CEOSCWIS1E CEOSCW1g1E CAPACITCR
02C5R13G104KL CSR13G104KEL FR1J50KS

02 JANIN9TaB JANINSTEE DICDE CODE-&
02M516995-28 M516395-28 SCEREW
02N51P3003F000 N51P3003F000 SCEEW
02RCOTGF2T73J RCOTGF273J RESISTCRE
02106B1293P009 106B1293F0059 RESISTCR
02250236-001 250230-001 CAPFLCITCR
02250239 250235 TRAMNSISTCR
02250241-001 250241-001 CCHHNECTCR

Figure 21: End of Task 2 - Exercise 1 result output
<terminated = IDBECApiAssignment [Java Application] C:\Program Files\IBMSDPidk\pin',

02930331-123 930331-123 FILTER
02930333-001 930333-001 DISCRIMINATC
02946325-08¢6 946325-086 FIN
02950060-006 9500680-006 REELLY
02954017-001 954017-001 RESISTOR
02958007-180 958007-180 RESISTCE
02980528-087 960528-087 REESISTCE
02983534-001 968534-001 SOCEET
02974810-010 974810-010 THERMOSTAT
02975105-001 975105-001 TELNSFCRMER
025989036-001 985036-001 TELNSFCRMER

1
1

Exercise 2 - Retrieve fields of a segment based on a conditional
statement

In this exercise, you will retrieve specific fields of a segment based on a conditional
statement by issuing a SELECT statement with a WHERE clause using the IMS
Universal JDBC driver.

Using the WHERE keyword
Use the WHERE keyword in SQL to select data conditionally. The syntax for a conditional select
query is:

SELECT column_name(s) FROM table_name WHERE column_name operator value

Note that for text values, the value must be enclosed in quotes. Operators on text values perform
binary comparisons. The IMS Universal JDBC driver converts the WHERE clause in an SQL query to
a segment search argument (SSA) list when querying a database. SSA rules restrict the type of
conditions you can specify in the WHERE clause.
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In line 20, construct a SQL query that will display all fields of the

PARTSPCB1.PARTROOT segment where the PARTKEY field is greater than

a ‘025’. Note that the PARTKEY field contains data that is alphanumeric.

e Set the query string to "SELECT * FROM PARTSPCB1.PARTROOT
WHERE PARTKEY > '025""

Press Ctrl + S to save your changes to the files.

Right click on the Java editor and select Run As > Java Application, as shown in

section 2.2.1.

An Errors in Workspace dialog box will appear but you can safely ignore it.

Click on Proceed to continue.

In the Console view, verify that the beginning of the result output looks like the

screenshot below.

Figure 22: Beginning of Task 2 - Exercise 2 result output

[2 Problems | @ Javadac @ Dedaration | Ca Annotations | Bl X |
<terminated > JDBCApiAssignment [Java Application] C:\Program Files\IBM\SDPYjdk\binjavaw. exe |
FARTEEY FLRT BLRTDESC
0256134-016 568134-016 HASeT1C1 NUT
0260003-118 60003-118 T7734304P8661T0 RES
02652540-002 652540-002 WIEE WELFP

02652799 6527495 FUOLSE TRAMNSFORMER
0268663-102 68663-102 CHOSC100EO3
0268663-104 68663-104 CHOSDZ200J03
0269857-635 69%857-635 CPROSRIKEIS3ES CLPLC
02T7060654P001 TO0e0&54P001 ELE TUEE
027438995P002 T438995P002 HOT

027454948P001 T7454949P001 LAME HOLDER
027618032P101 Tel8032P101 CAPACITCR

el
III ]
uyll
lllll
puil))
@
I
;
VX
\
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Exercise 3 - Order SQL query output by field values

In this exercise, you will retrieve data from a segment in sorted order issuing a SELECT
statement with an ORDER BY clause using the IMS Universal JDBC driver.

Using the ORDER BY keyword

Use the ORDER BY clause in SQL to sort the results of a SQL query in ascending or descending
order. The syntax for a ordered select query is:

SELECT column_name(s) FROM table_name ORDER BY column_name ASC|DESC

Note that ASC is used for ascending order and DESC is used for descending order. The field names
that are specified in an ORDER BY clause must match exactly the field name that is specified in the
SELECT statement.

1. Inline 20, construct a SQL query that will retrieve all fields of the
PARTSPCB1.PARTROOT segment and sort the results by the PART field in
descending order.

e Setthe query string to "SELECT * from PARTSPCB1.PARTROOT
ORDER BY PART DESC"

2. Press Ctrl + S to save your changes to the files.

3. Right click on the Java editor and select Run As > Java Application, as shown in
section 2.2.1.

4. An Errors in Workspace dialog box will appear but you can safely ignore it.
Click on Proceed to continue.

5. Inthe Console view, verify that the result output looks like the screenshots below.

Figure23: Beginning of the Task 2 - Exercise 3 result output

[‘“_ Problems | & Javadoc @ Dedaration ﬁ'@ Annotations | Bl Consale 2
«<terminated = JDBCApiAssignment [Java Application] C:\Program Files\IBM\SOP Yidk\bin'javaw.

FARTEEY FART FARTDESC
02RCOTGF273J RCOTGF2T3J RESISTCR
02HME51P3003F000 NS1P3003F000 SCEEW
02M516935-28 MS51e3595-28 SCEEW

02 JAN1INSTeE JANINSTEE DICDE CODE-4
02C5R13G104EL C5R13G104FL ER1JS0KS
02CEOSCW1B1E CEOSCWI1g1E CRPLACITCRE
024N960C10 AWN960C10 WASHER
02989036-001 983036-001 TELNSFORMER
02975105-001 975105-001 TELNSFORMER
02974810-010 974810-010 THERMOSTAT
02968534-001 968534-001 SOCEET
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igure 24: End of the Task 2 - Exercise 3 result output

(i LL TR, L L ST L o o o N
02252252-003 252252-003 COUELING
02250891 250891 SERVD VALLVE
02250796 250738 SWITCH
02250724 250724 RESISTOR
02250241-001 250241-001 CONNECTOR
02250239 250239 TRLNSISTOR
02250236-001 250236-001 CALPACITOR
02106B1253P005 106B1253P009 RESISTCE

Exercise 4 - Retrieve a specific field of a segment

In this exercise, you will retrieve a specific field in a segment. By querying only specific
fields instead of selecting all the fields in a particular segment, you can reduce network
overhead when using the IMS Universal JDBC driver.

In line 20, construct a SQL query that will display only the PART field from the
PARTSPCB1.PARTROOT segment.
e Setthe query string to "SELECT PART FROM

PARTSPCB1.PARTROOT"

Press Ctrl + S to save your changes to the files.

Right click on the Java editor and select Run As > Java Application, as shown in
section 2.2.1.

An Errors in Workspace dialog box will appear but you can safely ignore it. Click
on Proceed to continue.

In the Console view, verify that the result output looks like the screenshots below.

Figure 25: Beginning of Task 2 - Exercise 4 result output

(2 Problems | @ Javadoc | [&, i

<terminated > JDBECApiAssignment
FAERT
LNS9e0C1O
CEOSCW1B1EK
CSR13G104KEL
JEN1INSTaE
M3169595-28
NS1P3003F000
RCOTEF273J
106B1293P00%9
250236-001
250235
250241-001
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Figure26: End of Task 2 - Exercise 4 result output

<terminated > JDBCApiAssignment
930331-123

930333-001
946325-086
9500680-006
954017-001
958007-180
960528-067
968534-001
974810-010
975105-001
983036-001

Exercise 5 - Retrieve multiple fields from multiple segments

In this exercise, you will issue a SELECT query to retrieve data from segments that are
on the same and on different hierarchical paths in the IMS database. Note that the
PARTROOT and the BACKORDR segments are on the same hierarchic path, while the
CYCCOUNT segment is on a separate hierarchic path.

Retrieving fields from multiple segments

In SQL queries to relational databases, the JOIN keyword is typically used to query data from
multiple tables based on a relationship between the tables. IMS does not support using the JOIN
keyword explicitly, because IMS is a hierarchical database and it is possible that two segments are
unrelated to each other. However, an implicit join will be performed if the segments fall within the
same hierarchical path. The syntax for this is the same as for a SELECT query. Note that multiple
column names and table names can be specified as long as a comma is used to separate them. IMS
allows issuing a SELECT call to retrieve data from segments that are not on the same hierarchical
path, if a logical relationship has been defined between them.

1. Inline 20, construct a SQL query that will display the PART field from the

PARTSPCB1.PARTROOT segment and the BACKKEY field from the

PARTSPCB1.BACKORDR segment.

e Set the query string to ""SELECT PART, BACKKEY FROM
PARTSPCB1.PARTROOT, PARTSPCB1.BACKORDR"

Press Ctrl + S to save your changes to the files.

3. Right click on the Java editor and select Run As > Java Application, as shown in
section 2.2.1.

4. An Errors in Workspace dialog box will appear but you can safely ignore it.
Click on Proceed to continue.

5. Inthe Console view, verify that the result output looks like the screenshot below.

N
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Figure 27: Result output of Task 2 - Exercise 5 part 1

t Problems | @ Javadoc @ Declaration I_=@.ﬁ.r
<terminated > JDBCApiAssignment [Java Application

EFART BACEEEY
JRNINST 65 S0PR237942
250236-001 30PR265943
250236-001 30PR347921
250236-001 30PR426134
3003806 3050536609
3003806 3050536610
Tel8032F101 30PR14932%
Te1l8032F101 30PR149376
Tel8032F101 30PR153036
T618032F101 30PR153038
Te1l8032F101 30PR169566
TT73624TE001 30PR135640
925363-136 30PRT29437

6. Inline 20, construct a SQL query that will display the PHYSICALCOUNT field
from the PARTSPCB1.CYCCOUNT segment and the WORKORDER field
form the PARTSPCB1.BACKORDR segment.

e Setthe query string to "SELECT PHYSICALCOUNT, WORKORDER
FROM PARTSPCB1.CYCCOUNT, PARTSPCB1.BACKORDR™

Press Ctrl + S to save your changes to the files.

8. Right click on the Java editor and select Run As > Java Application, as shown in
section 2.2.1.

9. In the Console view, verify that the query fails with this error message: " The
tables BACKORDR and CYCCOUNT specified in the query cannot be
joined together. They are not along the same hierarchic path in the
database™.

~

e Task 3 —-Access IMS data with the IMS Universal DL/I

driver

In this task, you will write a Java application to connect to an IMS database and
manipulate data using a DL/I-based syntax with the IMS Universal DL/I driver.

What is DL/1?

Data Language/l (DL/I) is the IMS data manipulation language, which is a common high-
level interface between a user application and IMS. DL/I calls are invoked from application
programs written in languages such as Java, PL/I, COBOL, VS Pascal, C, and Ada. It also
can be invoked from assembler language application programs by subroutine calls. IMS lets
the user define data structures, relate structures to the application, load structures, and
reorganize structures.
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By using the IMS Universal DL/I driver, you can build segment search arguments (SSAS)
and use the methods of the program communication block (PCB) object to read, insert,
update, delete, or perform batch operations on segments. You can gain full navigation
control in the segment hierarchy.

Basic programming model for a Java application using the IMS Universal DL/I driver
In general, to write a IMS Universal DL/I driver application, follow these steps:

1. Import the com.ibm.ims.dli package that contains the IMS Universal DL/I driver
classes, interfaces, and methods.

2. Connect to an IMS database subsystem.

3. Obtain a program specification block (PSB), which contains one or more PCBs.

4. Obtain a PCB handle, which defines an application's view of an IMS database and
provides the ability to issue database calls to retrieve, insert, update, and delete

database information.

5. Obtain an unqualified segment search argument list (SSAList) of one or more
segments in the database hierarchy.

6. Add qualification statements to specify the segments targeted by DL/I calls.
7. If retrieving data, mark the segment fields to be returned.

8. Execute DL/I calls to the IMS database.

9. Handle errors that are returned from the DL/I programming interface.

10. Disconnect from the IMS database subsystem.

Connect to the IMS database through the IMS Universal DL/I driver

Before you can execute DL/I calls from your IMS Universal DL/I driver application, you
must connect to an IMS database.

Open the DLIAPIAssigment.java sample application

The DLIApiAssignment.java sample application
This sample application contains skeleton Java code for connecting to the IMS database and
issuing DL/I data access calls using the IMS Universal DL/I driver.

27
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1. From the Package Explorer view, expand IMSDBJavaApplicationLab > src >
com.ibm.ims.db.exercise.

Figure 28: Navigating to the DLIApiAssignment.java sample application

& Java - Welcome to z/0S Projects - IBM Rational Developer f
File Edit Source Refactor Mavigate Search Project Run  Window

i - 0-Q- 4 EEHEG S
(& Package Explor &3 'E: Hierarchy =08 ‘j Welcome to z/05 Pro;
BEE

= &> IMSDBJavaApplicationLab

-5 src
B} com.ibm.ims.db.databaseviews WEICOI'I'IE
=g com.ibm.ims.db.exercse
@ DLIApiAssignment.java B
m InputMessage.java

[J| IBPApplication.java

2. From the Package Explorer view, double click on the file
DLIApiAssignment.java to open the sample application in the Java editor.

Figure 2915: The opened DLIApiAssignment.java sample application in the Java editor
#J| DLIApiAssignment.java &3

package com.ibm.ims.db.exercise;
Fimport com.ibm.ims.dli.DLIERCception;[]
Purpose: This client application is a sample that is used in the EM4Z Sandbox
and IMS S50 Workshops to demonstrate the capabilities of DL/I for Java AFI
that is shipped with the Universal Drivers(imsudb.jar) with the service
process in IMS Vi1l.
Thizs sample accesses the Parts database provided in the IMS IVE.
Thisz application uses the IVPDEl1l DE and DFS5IVP1 PS5E Heeds as input 5
parameters IF address Port Number IMS5 alias name defined in ODBM UserName

Password

Created: 08/06/2009

28




Set the connection properties

1. Inthe Java editor, scroll down the application source code until you find the Java

main method shown in the screenshot below.

Figure 30: Javamain method in the DLIApiAssignment sample application
¢4 DLIApiAssignment.java &2

w

puoblic =tatic void main(String[] args) {
DLIApiA=ssignment dliAPT = new DLIApiAssignment ()

dliaPTY.dliMethod ( BEEPLACE THIS j;

N

the driver connectivity type IMSConnectionSpec.DRIVER_TYPE_4

In line 56 of the code, verify that host is set to "'zserveros.demos.ibm.com™
In line 57 of the code, verify that the datastoreName is set to “IMSD”

In line 58 of the code, verify id "EM4ZIMS" is set to username.

© kAW

you.
7. Inline 82 of the code, verify that the metadataURL is set to the string

"class://com.ibm.ims.db.databaseviews. DFSSAMO09DatabaseView"
8. Press Ctrl + S to save your code changes.

After completing this step, your Java application should be ready to connect using the
Universal DL/l driver. Next, you will need to modify the Java application code to issue
data access calls to IMS.

Issue DL/I calls to access the IMS database

The following exercises in this section will show you how to issue DL/I calls in your Java application to
retrieve data from the IMS database using the IMS Universal DL/l driver.

Lab exercises

In line 44 of the code, REPLACE_THIS is already corrected for you to indicate

F/Call a method or subroutine to make wvarious IMS5 calls
— The dliMethod i= defined to accept a parameter of the Driwv
we are making database calls on the
we are making database calls from an
f ¥You can either provide the integer value for the driver type or

In line 60 of the code, verify that the drdaPort value 7001 has already been set for

This task contains several programming exercises for you to complete. These exercises will help to

familiarize you with basic data access operations using the IMS Universal DL/I driver. At certain

points indicated in the instructions, you will be asked to provide the correct code. For your reference,
we have provided the exercise solutions. You can find the code with the exercise solutions from the

Package Explorer view by opening IMSDBJavaApplicationLab >

-
-
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com.ibm.ims.db.exercise.solution > DLIApiAssignment.java

Exercise 1 - Retrieve data in an IMS database

In this exercise, you will retrieve data in an IMS database by issuing DL/l Get Unique
and Get Next calls through the IMS Universal DL/I driver.

Using the Get Unique (GU) and Get Next (GN) DL/I calls

If an input message contains more than one segment, a Get Unique call retrieves the first segment of
the message and Get Next (GN) calls retrieve the remaining segments.

When issued from the IMS Universal DL/I driver, the Get Unique call retrieves a specific segment or
collection of segments on a hierarchic path from an IMS database. The GU call also establishes the
position in the database from which additional segments can be processed in a forward direction.

The Get Next call retrieves the next segment or collection of segments on a hierarchic path from an
IMS database. The GN call usually proceeds forward along the hierarchy of a database from the
current database position to the next required segment. To modify the GN call to start at an earlier
position than the current position in the database, you can use an IMS command code. The Get Next
call returns a Path object representing the hierarchic path from the root segment to the segment the
cursor is currently positioned on. The Path object includes the data stored in the segments along the
hierarchic path.

Exercise 1 begins on line 103 of the DLIApiAssignment.java sample application, where
the function displayPARTROOT (psb) isinvoked. To go to the start of the function,
go to line 107, move the mouse over the displayPARTROOT (psb) function
invocation, and press F3.

Figure 31: Navigating to the start of Exercise 1
¢4 DLIApiAssignment.java &2

'/ Exercise 1: Issue Get Unigque and Get Hext cal
f for Java
/ TUzez getlUnique and getNext calls.
Svaztem.ont.println("Starting Exerci=se 1:");

displayPARTROCT (psb) ;
System.ocut.println("Completed Exercise 1%wn'n"):

Exercise 1 - Step 1: Define an unqualified SSAL.st to specify the
segments to retrieve
1. Inline 146 of the code, delete the constant REPLACE_THIS and replace it with

the Java code statement to get an unqualified SSAList for the PARTROOT
segment. You can find the answer after Figure 32 below.

L
>
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Use the PCB object that has been created (partspcbl) to call the getSSAL.ist(String)
method. Pass in the segment name (""PARTROOT™) as the input parameter.

The ssAList interface

The com.ibm.ims.dli.SSAList interface represents a list of segment search arguments (SSAS)
used to specify the segments to target in a particular database call. Use the SSAList interface to
construct each segment search argument in the list, and to set the command codes and lock class for
the segment search arguments. Each SSA in the SSAList can be qualified or unqualified. A SSA
gualification can be used to filter the segments to update or retrieve on a hierarchic path.

Figure 32: Defining the unqualified segment search argument list
¢4 DLIApiAssignment.java 52
private void displayPARTRCOT (PSE pshb) {
try {
'/ Get an instance of the PCE PARTSPCE1L

PCE partspcbhbl = psb.getPCEB ("PLRTSECEL™)

— Create the 55AList using the PCE partspcbl.
‘ Do this by using the pckh to build an ungualified 55A Listc
: /4 containing a single segment/parameter: PARTROOT
% SSAList ssalist =

Verify your Java code statement:
In line 146, your Java code statement should look like this:

SSAList ssalist = partspcbl.getSSAList ("PARTROOT") ;

Exercise 1 - Step 2: Issue a Get Unique DL/I call to retrieve segments
1. Inline 164 of the code, delete the constant REPLACE_THIS and replace it with

the Java code statement to issue a Get Unique DL/I call. You can find the answer
after figure 33 below.

Hint:
Use the PCB object that was previously created (partspcbl) to call the getUnique(Path,
SSAL.ist, boolean) method.
e Pass in the Path object that was previously created (path) as the 1% input
parameter.
e Pass in the SSAList object that was previously created (ssaList) as the 2" input
parameter.
e Pass in the boolean value false as the 3" input parameter. False indicates that this
DL/I call is not a Get Hold Unique call.
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Figure 33: Insert code to issue the Get Unique call
¢ DLIApiAssignment.java &2

{ TODD — Make a Get Unigue call using partspchbl

f The call takes 3 parameters: Path, 554List, and a boolean

f indicating if this i=s a HOLD call (GHU, GHHN, GHNP).

 The call will return true if the call is successful or false if

Ff not.

2 l(rEpLaCcE THIS|IN
// Format the output
System.out.println ("EARTEEY \t\tPART\t\tBPARTDESC") ;
Sy=tem.out.println{"------- - - - - - - -\ --" - b e ——_————————————— -

Verify your Java code statement:
In line 164, your Java code statement should look like this:

if (partspcbl.getUnique (path, ssalist, false)) {

Exercise 1 — Step 3: Issue a Get Next DL/I call

1. Inline 178 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to issue a Get Next DL/I call. You can find the answer
after Figure 34 below.

Hint:
Use the PCB object that was previously created (partspcbl) to call the getNext(Path,
SSAL.st, boolean) method.
e Pass in the Path object that was previously created (path) as the 1% input
parameter
e Pass in the SSAList object that was previously created (ssaList) as the 2™ input
parameter
e Pass in the boolean value false as the 3 input parameter, to indicate that this
DL/I call is not a Get Hold Next call.

Figure 34: Insert code to issue a Get Next call
¢4 | DLIApiAssignment.java &

' TODO — Make a get Hext Call

 How lets continue to get more results by calling ge
(GH} . The getHext Java call i=s used similarly to th

{ however this time we will use a while loop to go th

f zegments matching the S554List are returned.

while (EINSRASIREIE) {

Svztem.out.println({path.getString ("PARTEEY") .trim(
+ "Swt4Yt" 4+ path.getString("PALRTDESC™) .trim
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Verify your Java code statement:
In line 178, your Java code statement should look like this:
while (partspcbl.getNext (path, ssalist, false)) {

Exercise 1 — Step 4: Run the application and verify the output results

1. PressCtrl + S tosave your changes to the files.
2. Right click on the Java editor and select Run As > Java Application.

Figure 35: Running the Java application
¢9| DLIApiAssignment.java &7

E, SATODO — Try running the application
+ catch (DLIException e) {

< Undo Typing Cirl+Z

= private Open Dedaration F3 atchRetrieve (PSE psb) {

try Open Type Hierarchy F4
Open Call Hierarchy — Ctrl+alt+H ECE PRRETSECEL
Show in Breadcrumb — Alt+5hift+8 ("PRETSECEL") ;

Quick Outline Cirl+0 Lifiea

ungualifi 554 List contain
Quick Type Hierarchy Ctrl+T naaE EE =es = oREELD
Show In Alt+shift+w *

1.get55AList ("PRARTROCT™) ;

Copy Qualified Name rieve call
Faste Crl+v h=zsue a batchBetrieve

hSet or a set of ICAREA'"s.
Quick Fix Cirl+1 presents data from a single
Source Alt+shift45 » mtabase.
Refactor Alt+shift+T ¥
Local History 4

WYt CPART\C\CPRARTDESC") ;
References 4

Dedarations 4

[ Add to Snippets... Hoesn't hawve another path.

B 1Runonsever At R

Debug As Ml 55 2 3ava Application  Alt+shift+x, 3
Profie As 3

validate Run Configurations...

Team ’ tl get5tring ("PARTKEY"}.trim()

3. An Errors in Workspace dialog box will appear but you can safely ignore it.
Click on Proceed to continue.
4. Inthe Console view, verify that the output results look like the screenshots below.
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Figure36: Beginning of Exercise 1 result output in the Console view

[3_ Problems | @ Javadoc @ Dedaration E‘@ Annotations | Bl Consale 52 i
<terminated = DLIApiAssignment [Java Application] C:\Program Files\IBMSDPYjdk\bin'javaw. exe (Mo
lOpenDEIVE main

Host: zserveros.demos.ibm. com

IMS5 Connect's DRDA port: 7001

IM5 Datastore name: IMSD

Starting Exercise 1:

PARTEEY FAERT PARTDESC

024N960C10 AN960C10 WASHER
02CEOSCWI1B1K CEOSCWI1g1E CAPACITCRE
02C5R13G104EL C5R13G104FL ER1JS0KS

02 JANINST 65 JANINSTEE DICDE CODE-&
02M516995-28 HM5165995-28 SCEEW

Figure 37: End of Exercise 1 result output in the Console view

025974810-010 974810-010 THERMOSTAT
02975105-001 89753105-001 TERANSFORMER
025989036-001 989036-001 TERANSFORMER

Completed Exercise 1

Exercise 2: Retrieve batch data in an IMS database

In this exercise, you will retrieve batch data from an IMS database by issuing a Batch
Retrieve call through the IMS Universal DL/I driver.

Batch Retrieve

You can use the batch retrieve call to retrieve multiple segments from an IMS database in a single
call. Instead of a client application making multiple GU and GN calls, IMS performs all the GU and
GN processing and returns the results back to the client in a single batch network operation. The
fetch size property determines how much data is returned on each batch network operation.

Exercise 2 begins on line 110 of the DLIApiAssignment.java sample application. At the
beginning of Exercise 2, the code for this exercise has been commented out.

Exercise 2 — Step 1: Uncomment the code for Exercise 2

1. Inthe Java editor, highlight lines 112 to 114 of the DLIApiAssignment.java
sample application and press Ctrl + / touncomment the code.
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Figure 3816: Code for Exercise 2 (before uncomment)
#| *DLIApiAssignment.java

' Exercise 2: Use batchBRetrieve for the DL/I API
'/ Uses batchBEetrieve calls.
System.out.println("Starting Exerci=se 2:");

displayPARTROCTUsingBatchRetrieve (pshb) -

System.out.println ("Completed Exercise 24Ywnhn"):

Code comments allows comment statements that will not be compiled and executed to be inserted
directly into the application source code. In Explorer, blocks of code can be commented and
uncommented by highlighting that block and pressing Ctrl + /.

Figure 39: Code for Exercise 2 (after uncomment)
| *DLIApiAssignment.java 52

'/ Exercise 2: Use batchBRetrieve for the DL/I APT £«
{ Uses batchRetrieve calls.
System.cut.println("Starting Exercise 2:");
di=splavyPARTROOTU=zingBatchRetrieve (pahb) ;
System.out.println("Completed Exercise 2%\n\n"):

2. The function displayPARTROOTUsingBatchRetrieve contains the Java
code for the batch retrieval operation. In line 113, move your mouse over the

displayPARTROOTUsingBatchRetrieve (psb) function invocation and
press F3 to open the function declaration.

Exercise 2 — Step 2: Issue a Batch Retrieve call to retrieve multiple
segments
1. Inline 210 of the code, delete the constant REPLACE_THIS and replace it with

the Java code statement to issue a Batch Retrieve call. You can find the answer
after the figure below.

Hint:
Use the PCB object that was previously created (partspcbl) to call the
batchRetrive(SSAL.ist) method.

e Pass in the SSAList object that was previously created (ssaL.ist) as the input
parameter.

[fom]|
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Figure 40: Insert code to issue a batch retrieve call
¢4 | DLIApiAssignment.java 52

— Make a Batch Retriewve call
* Using the pchb, vou can issue a batchRet
/{ which will return a PathSet or a set of
 Each path in the =set represents data fr
' zegment or row in the database.

PathSet p=z = REPLACE THIS:

Verify your Java code statement:
In line 210, your Java code statement should look like this:

PathSet ps = partspcbl.batchRetrieve (ssalist) ;

Exercise 2 — Step 3: Commit the unit of work

1. Inline 227 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to commit your unit of work. You can find the answer
after the figure below.

Hint:
Use the PSB object was previously created (psb) to call the commit() method.

Committing and rolling back DL/l transactions

The IMS Universal DL/I driver provides support for local transactions with the commit and rollback
methods. A local transaction consists of a unit of work with several units of recovery. An IMS
Universal DL/I driver application can commit or roll back changes to the database within a unit of
recovery. In the IMS Universal DL/I driver, the local transaction is scoped to the PSB instance. No
explicit call is needed to begin a local transaction. After the unit of work starts, the application makes
DL/I calls to access the database and create, replace, insert, or delete data. The application commits
the current unit of recovery by using the PSB. commit method. The commit operation instructs the
database to commit all changes to the database that are made from the point when the unit of work
started, or from the point after the last commit or rollback method call, whichever was most recent.

Figure 41: Insert code to issue a commit call
i | DLIApiAssignment.java 52

— Issue a commit using th
f Commit to complete yvour unit o

REPLACE THIS:

Verify your Java code statement:
In line 227, your Java code statement should look like this:
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psb.commit () ;

Exercise 2 — Step 4: Run the application and verify the output results

1. PressCtrl + S tosave your changes to the files.

2. Right click on the Java editor and select Run As section > Java Application, as
shown in section 3.2.1.4.

3. An Errors in Workspace dialog box will appear. Click on Proceed.

4. Inthe Console view, verify that the output results look like the screenshots below.

Figure 42: Beginning of Exercise 2 result output in the Console view
[/ Problems | @ Javadoc | [, Dedaration | Bl Consale £2
<terminated = DLIApiAssignment [Java Application] C:Program Files\IBM\SDP_1Yjidk\bin'javaw.exe (Sep 16, 20

Starting Exerci=ze 2:

FARTEEY FLRT FARTDESC

02AN960C10 ANSe0C10 WASHER
02CEOSCW1S1E CEOSCWI1E1E CAPACTITCRE
02C5R13G104EL CS5R13G104FL ER1JS0ES

02 JANINST 6B JANINST 6B DICDE CCODE-&

Figure 43: End of Exercise 2 result output in the Console view

02974810-010 974810-010 THEEMOSTAT
02975105-001 975105-001 TEANSFORMER
02989036-001 9859036-001 TEANSFORMER

Conpleted Exercise 2

Exercise 3: Create SSALists with multiple segments, specify
qualifications, and mark specific fields for retrieval
In this exercise, you will mark specific segment fields for retrieval from the IMS database.

You will also specify the number of rows of data for the IMS Universal DL/I driver to
retrieve.

Marking segment fields for retrieval with the IMS Universal DL/I driver

In your Java application, you can specify which segment fields are to be returned from a database
retrieve call by using the markFieldForRetrieval orthe markAllFieldsForRetrieval
methods. Following the IMS default, all of the fields in the lowest level segment specified by the
SSAList are initially marked for retrieval.

The markFieldForRetrieval method

This SSAList method is used to mark a specific field for retrieval from the database. The
markFieldForRetrieval method is used together with getPathForRetrieveReplace() and
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with the data retrieval methods in the PCB interface. When a retrieve call is made, the resulting Path
object will contain all the fields that have been marked for retrieval.

The markAllFieldsForRetrieval method

This method is used to mark all fields in the specified segment for retrieval from the database. The
markAllFieldsForRetrieval method is used together with getPathForRetrieveReplace () and
with the data retrieval methods in the PCB interface. When a retrieve call is made the resulting Path
object will contain only the fields marked for retrieval. Following the IMS default, all of the fields in the
lowest level segment specified by the SSAList are initially marked for retrieval.

Exercise 3 begins on line 116 of the DLIApiAssignment.java sample application. At the
beginning of Exercise 3, the code for this exercise has been commented out.

Exercise 3 — Step 1: Uncomment the code for Exercise 3

1. Inthe Java editor, highlight lines 118 to 120 of the DLIApiAssignment.java
sample application and press Ctr1l + / to uncomment the code.

Figure 44: Code for Exercise 3 (before uncomment)
¢4 DLIApiAssignment.java &2

/ Exercise 3: Creating 55A Lists with multiple =
'Y gualifications, and marking specific fields fo

Sy=stem.out. ("Starting Exercise 3:");
displayBACKORDR (psk) ;

System.out.p? ("Completed Exercise 3\n\n"):

Figure 45: Code for Exercise 3 (after uncomment)
f| *DLIApiAssignment.java

'/ Exercise 3: Creating S54 Lists with multiple
f gqualification=s, and marking specific fields :

System.cut.println("Starting Exercise 3:");

di=splavyBACECRDE (p=sh)

System.out.println ("Completed Exercise 3hnhn"):

2. The function displayBACKORDR contains the Javacode for the retrieval. In
line 119, move your mouse over the displayBACKORDR (psb) function
invocation and press F3 to open the function declaration.

Exercise 3 — Step 2: Build an unqualified SSAL st

1. Inline 246 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to build an unqualified SSALIist for a hierarchic path of
segments ranging from the top-level PARTROOT segment to the bottom-level
BACKORDR segment. You can find the answer after the figure below.
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Hint:
Declare a new SSAL.ist variable (ssaList). Use the PCB object that has been created
(partspcbl) to call the getSSAL.ist(String, String) method.
e Pass in the PARTROOT segment name ("PARTROOT") as the 1% input
parameter
e Pass in the BACKORDR segment name ("BACKORDR") as the 2" input
parameter

Figure 46: Insert code to build the unqualified SSAList
| *DLIApiAssignment java 22

- Ty T

EEPLACE THIS:

Verify your Java code statement:
In line 246, your Java code statement should look like this:

SSAList ssalist = partspcbl.getSSAList ("PARTROOT", "BACKORDR") ;

Exercise 3 - Step 3: Mark the fields to retrieve

1. Inline 262 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to mark the WORKORDER field for retrieval from the
BACKORDR segment. In line 263, add the Java code statement to mark the
ORDERQTY field for retrieval from the same segment. You can find the answer
after the figure below.

Hint:
Use the SSAL.st object that has been created (ssaL.ist) to call the
markFieldForRetrieval(String, String, boolean) method.
e Pass in the segment name (""BACKORDR") as the 1% input parameter, to
indicate the name of the segment in the SSAL.st containing the field
e Pass in the field name ("WORKORDER") as the 2" input parameter, to indicate
the name of the field to be marked for retrieval from the database
e Pass in the boolean value true as the 3" input parameter, to indicate that this field
should be retrieved from the database
In the next line, create a similar statement to mark the ORDERQTY field for retrieval.
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Figure 47: Insert code to mark the segment fields to retrieve
¢4 DLIApiAssignment.java &2

- Only retrieve specific field=s (1
 How we only want two fields to be retul
f/ ——>» WORKORDER and ORDERQTY

f Uze the markFieldForRetrieval method.
zzalist . REPLACE THIS:

Verify your Java code statement:
In line 262 and 263, your Java code statements should look like this:

ssalist.markFieldForRetrieval ("BACKORDR", "WORKORDER", true):;
ssalist.markFieldForRetrieval ("BACKORDR", "ORDERQTY", true);

Exercise 3 — Step 4: Specify the number of rows to fetch per network
call

1. Inline 274 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to set the fetch size property to 30. You can find the
answer after the figure below.

Hint:
Use the PCB object that has been created (partspcbl) to call the setFetchSize(int)
method.

e Set the number of rows to fetch (30) as the 1* input parameter

Fetch size property

The fetch size is the number of rows physically retrieved from the IMS database per network call. A
list of rows is represented by a Path instance containing one or more segments that match the
segment search argument criteria specified by an SSAList. This is set for you internally. You can
also set the fetch size using the setFetchSize method from the PCB interface. Setting the fetch
size allows a single request to return multiple rows at a time, so that each application request to
retrieve the next row does not always result in a network request.

Figure 48: Insert code to change the fetch size
¢4 | DLIApiAssignment.java 52

— U=zing the PCE specify how many rc
' Set the fetch =size for IM5 to send back
f Thi=s helps to cut down on the number of

partspchbl .REPLACE THIS:
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Verify your Java code statement:
In line 274, your Java code statement should look like this:
partspcbl.setFetchSize (30) ;

Exercise 3 — Step 5: Print the retrieved segment fields from the path

1. In line 287 of the code, delete the 1 instance of the constant REPLACE_THIS
and change the System.out.println statement to print the value of the
WORKORDER field returned by IMS. In the same line, delete the 2" instance of
the constant REPLACE_THIS and change the Java code statement to print the
value of the ORDERQTY field returned by IMS. You can find the answer after
the figure below.

Hint:
Use the Path object that has been created (path) to call the getString(string) method.
e Set the 1% parameter to the field name (""WORKORDER"), to retrieve the value
of this field.
Use a similar method call to retrieve the value of the ORDERQTY field.

Figure 49: Modifying the System.out.printin statement to print the retrieved segment fields
£ i

- + NGIODEOADhTD - ORNEFROTY = .
— Print WORECEDEE and CORDERQTY from the path

f '4' i= used to concatenate string values

System out.println(REPLACE THIS + "\t\t" + REPLACE THIS):

Verify your Java code statement:
In line 287, your Java code statement should look like this:

System.out.println (path.getString ("WORKORDER") + "\t\t" +
path.getString ("ORDERQTY") ) ;

Exercise 3 — Step 6: Run the application and verify the output results

1. PressCtrl + S tosave your changes to the files.
2. Right click on the Java editor and select Run As > Java Application, as shown in
section 3.2.1.4.
. An Errors in Workspace dialog box will appear. Click on Proceed.
4. Inthe Console view, verify that the output results look like the screenshots below.
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Figure 50: Exercise 3 result output in the Console view
(2 Problems | @ Javadoc | [, Dedaration | El Console 3

<terminated = DLIApiAssignment [Java Application] C:\Program Files\BMSDP_1%jdkbin awi
Starting Exerci=e 3:

WORECORDER CRDERQTY
OPR148932 10
OPR14837 10
OPR15309 10
OPR15309 10
OPR168956 a0

Completed Exercise 3

Exercise 4: Utilize command codes for DL/I

In this exercise, you will add a command code in the SSAL.ist to retrieve a sequence of
segments.

Command codes for DL/I

SSAs can also include one or more command codes, which can change and extend the functions of
DL/l calls. For example, you can use the D command code to retrieve or insert a sequence of
segments in a hierarchic path with one call rather than retrieving or inserting each segment with a
separate call. A call that uses the D command code is called a path call.

Exercise 4 begins on line 122 of the DLIApiAssignment.java sample application. At the
beginning of Exercise 4, the code for this exercise has been commented out.

Exercise 4 — Step 1: Uncomment the code for Exercise 4

1. Inthe Java editor, highlight lines 123 to 125 of the DLIApiAssignment.java
sample application and press Ctr1l + / to uncomment the code.

Figure 51: Code for Exercise 4 (before uncomment)
¢¥| DLIApiAssignment.java &2

ercise 4: Utilizing IMS5 Command Codes in you

Figure 52: Code for Exercise 4 (after uncomment)
#l| *DLIApiAssignment.java 2

/{ Exercis=se 4: Utilizing IMS Command Codes in v
Sy=stem.out.println("Starting Exercise 4:");
di=splavyPARTROCTandBACECORDEData (pshb)
System.out.println ("Completed Exercise 4%ywnhn"):

42




2. The function displayPARTROOTandBACKORDER contains the code for the
batch retrieval operation. In line 124, move your mouse over the
displayPARTROOTandBACKORDRData (psb) function invocation and press
F3 to open the function declaration.

Exercise 4 — Step 2: Add a command code to the SSAL.ist

1. Inline 333 of the code, delete the constant REPLACE_THIS and replace it with
the Java code statement to add the D command code. You can find the answer
after the figure below.

Hint:
Use the SSAL.st object that has been created (ssaL.ist) to call the addCommandCode
(String, byte) method.

e Set the name of the segment ("PARTROOT") as the 1% input parameter

e Set the command code (SSAList.CC_D) as the 2" input parameter

Figure53: Insert the code to add an IMS command code
ﬁﬂ DLIApiAssignment.java &5

- Add an TMS command code to the 55

f/ We want to retriewve data from both PARTES
'/ order to do this in IMS5 you need to add |
{ to the PARTROCT because the way the S5AL:
f yvou Wwill only get data from the leaf seq

f/ Lfter adding the command code D the 554
f/ BARTROCT *D(PARTEEY = 027618032P101 )
ff BTOESTATS

'/ BACEFORDR

¢ Tze the addCommandCode method.

REFPLACE THIb

=

Verify your Java code statement:
In line 333, your Java code statement should look like this:

ssaList.addCommandCode ("PARTROOT", SSAList.CC D);

Exercise 4 — Step 3: Run the application and verify the output results

1. PressCtrl + S tosave your changes to the files.
2. Right click on the Java editor and select Run As > Java Application, as shown in
section 3.2.1.4.

ﬂ
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Figure 5417: Exercise 4 result output in the Console view
[/ Problems | @ Javadoc | [, Dedaration | B Consdle &2

3.

In the Console view, verify that the output results look like the screenshots below.

<terminated > DLIApiAssignment [Java Application] C:\Program Files\IBMSDP _1Ydk\binjavaw. exe (Sep 16, 2009 6: 1429 PM)

Starting Exercise 4:
PARTEEY

027618032P101
027618032FP101
027618032P101
027618032P101
027618032P101
Completed Exercise 4

|n
5
/
-
Q"
\

FARTDESC

CAPACITOR
CAPLACITOR
CAPLACITOR
CAPACITCR
CAPACITCR
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WORECEDER

OFR14532
OPR14537
OPR15309
OPR15309
OPRl1e956

CRDERQTY

10|
10
10
10
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